Infrastructure Navigator Installation and Administration Guide

vCenter Infrastructure Navigator 2.0.0

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

vCenter Infrastructure Navigator Installation and Administration Guide  5

1  vCenter Infrastructure Navigator Overview   7
   vCenter Infrastructure Navigator Functionality   7
   vCenter Infrastructure Navigator Target Users and Benefits  8
   vCenter Infrastructure Navigator Architecture  8
   Components of vCenter Infrastructure Navigator  9

2  Installing vCenter Infrastructure Navigator   11
   Register vCenter Server 5.0 System with the vSphere 5.1 Web Client   11
   Register vCenter Server with the vSphere Web Client from the Command-line   12
   Virtual Machine Requirements  13
   ESX/ESXi Requirements for vCenter Infrastructure Navigator  13
   Software Requirements for vCenter Infrastructure Navigator  14
   vCenter Infrastructure Navigator Port Requirements  14
   Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Web Client   15
   Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client   16
   Using vCenter Single Sign-On with vSphere   17

3  Setting Up vCenter Infrastructure Navigator   19
   vCenter Infrastructure Navigator Licensing  19
   Privileges Required for vCenter Infrastructure Navigator  21
   Select vCenter Server   24
   View System Information  24
   Managing Application Discovery  25
   Update vCenter Credentials  26
   Site Recovery Manager Integration with vCenter Infrastructure Navigator  26
   Update SRM Administrator Credentials  27
   Creating Product Support Package  27
   Upgrading vCenter Infrastructure Navigator Knowledge Base  28
   vCenter Infrastructure Navigator Log Files  28

4  Security Overview  29
   Firewall for vCenter Infrastructure Navigator  29
   Protecting Sensitive Files  30
   Securing vCenter Infrastructure Navigator  30

5  Upgrading vCenter Infrastructure Navigator  31
   vCenter Infrastructure Navigator Upgrade  31
   Upgrade vCenter Infrastructure Navigator by Using Web Console  32
   Upgrade Limitation for vCenter Infrastructure Navigator  32
6 Uninstalling vCenter Infrastructure Navigator 33
   Uninstall vCenter Infrastructure Navigator Plug-in 33

7 Troubleshooting vCenter Infrastructure Navigator 35
   vCenter Certificate Error 35
   Plug-In Does Not Work in vSphere Web Client After an Upgrade 36
   Error in Retrieving Information Might Occur 36
   Incorrect Marking of a Virtual Machine as an External Machine 36
   Deployment Failure After IP Address Change 37
   Failure of the Virtual Appliance After DHCP Selection 37
   VMware Tools Compatibility Error 37
   vCenter Infrastructure Navigator Authentication Failure 37
   Navigation Problem Between Objects 38
   Navigation Error 38
   Error Message in Recent Tasks List 38
   vCenter Infrastructure Navigator Plug-in Removal Failure 39

Index 41
vCenter Infrastructure Navigator Installation and Administration Guide

The VMware vCenter Infrastructure Navigator Installation and Administration Guide provides information about installing and configuring of VMware® vCenter™ Infrastructure Navigator™.

vCenter Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

Intended Audience

This information is intended for virtual infrastructure administrators who are familiar with virtual machine technology and datacenter operations.
vCenter Infrastructure Navigator is an application awareness plug-in to the vCenter Server that provides continuous dependency mapping of applications.

vCenter Infrastructure Navigator offers application context to the virtual infrastructure administrators to monitor and manage the virtual infrastructure inventory objects and actions. Administrators can use vCenter Infrastructure Navigator to understand the impact of the change on the virtual environment in their application infrastructure.

**Note**  Plug-ins (also referred to as Extensions) expand the capabilities of vCenter Server by adding features and functionality to the base product.

This chapter includes the following topics:

- “vCenter Infrastructure Navigator Functionality,” on page 7
- “vCenter Infrastructure Navigator Target Users and Benefits,” on page 8
- “vCenter Infrastructure Navigator Architecture,” on page 8
- “Components of vCenter Infrastructure Navigator,” on page 9

**vCenter Infrastructure Navigator Functionality**

vCenter Infrastructure Navigator provides a centralized view of your application environment.

vCenter Infrastructure Navigator performs the following high-level functions:

- Maps virtual infrastructure resources such as virtual machines, Web servers, mail servers, database servers, application servers, cache servers, messaging servers, application management servers, and virtualization management servers.
- Displays relationships between virtual machines and external machines through services.
- Allows you to detect inconsistencies from the norm.
- Allows you to take advantage of integration with other VMware products such as vCenter Server, VMware vCenter Site Recovery Manager (SRM), and vCenter Operations Manager.
- Allows you to define multi-tier application pattern and then discovers all of this pattern instances in the vCenter Server. You can then view these application instance maps.
- Allows you to create or define manual applications that in turn allow you to track a group of virtual machines.
- Allows you to create or define roles that you can use to find instances of the applications in your environment.
**vCenter Infrastructure Navigator Target Users and Benefits**

vCenter Infrastructure Navigator creates a detailed model of the application environment and offers application context to its users.

vCenter Infrastructure Navigator helps virtual infrastructure administrators to accurately answer the following questions:

- Which application services are running on my virtual machines?
- What are the dependencies among application services running on different virtual machines?
- Where are the hidden optimization opportunities and how can I capitalize on them?
- How do certain application changes impact my environment?
- What are the risks involved in making changes in the virtual environment?
- How do certain virtual machine's issues impact application operation and how can I prevent or solve these issues?
- How the integration with SRM and vCenter Operations Manager benefits the users?

**vCenter Infrastructure Navigator Architecture**

vCenter Infrastructure Navigator is a virtual appliance that you can deploy on the vCenter Server. A virtual appliance is a virtual machine image that contains software designed to run in a virtual machine.

With the components of vCenter Infrastructure Navigator, you can map services running in your virtual environment, examine the application discovery status, view and analyze the dependency map, and have a centralized view of the entire application environment.

The architecture illustrates various components of vCenter Infrastructure Navigator and their dependencies.

*Figure 1-1. vCenter Infrastructure Navigator Architecture Diagram*
Components of vCenter Infrastructure Navigator

A component is a software or software design with a well-defined interface. A component represents specific behavior of the system.

The following table lists and describes principal components of vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server in vCenter Infrastructure Navigator virtual machine</td>
<td>The Server component reconciles the data from Active Discovery and transfers the data to the Database component.</td>
</tr>
<tr>
<td>Database in vCenter Infrastructure Navigator virtual machine</td>
<td>The Database component stores the data received from the Server component. The Database component also stores vCenter Infrastructure Navigator configurations. <strong>Note</strong>: vCenter Infrastructure Navigator does not support storing of data in an external database.</td>
</tr>
<tr>
<td>vCenter Infrastructure Navigator Plug-In in the vSphere Web Client</td>
<td>The vCenter Infrastructure Navigator Plug-In in the vSphere Web Client provides a graphical user interface that you use to view and analyze dependencies.</td>
</tr>
<tr>
<td>Inventory Service</td>
<td>Inventory service is a vSphere component to which vCenter Infrastructure Navigator exports its data.</td>
</tr>
</tbody>
</table>
vCenter Infrastructure Navigator is a virtual appliance that can run in a VMware virtual infrastructure. You must ensure that your environment meets requirements so that you can deploy and use the vCenter Infrastructure Navigator virtual appliance.

This chapter includes the following topics:

- “Register vCenter Server 5.0 System with the vSphere 5.1 Web Client,” on page 11
- “Register vCenter Server with the vSphere Web Client from the Command-line,” on page 12
- “Virtual Machine Requirements,” on page 13
- “ESX/ESXi Requirements for vCenter Infrastructure Navigator,” on page 13
- “Software Requirements for vCenter Infrastructure Navigator,” on page 14
- “vCenter Infrastructure Navigator Port Requirements,” on page 14
- “Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Web Client,” on page 15
- “Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client,” on page 16
- “Using vCenter Single Sign-On with vSphere,” on page 17

Register vCenter Server 5.0 System with the vSphere 5.1 Web Client

To enable connectivity to a vCenter Server 5.0 system with the vSphere Web Client 5.1, you need to register it with the vSphere Web Client using the vSphere Web Client Administration Tool.

The vSphere Web Client is a Web application that can reside either on the same system as vCenter Server or a separate system. Before you can connect to a vCenter Server 5.0 system with the vSphere Web Client, you must register the vCenter Server 5.0 system with the vSphere Web Client. Unregister a vCenter Server system when you no longer want users to be able to access it using a particular instance of the vSphere Web Client.

You need not register vCenter Server 5.1 systems that use the same vCenter Single Sign On server as the vSphere Web Client. The vSphere Web Client can locate such vCenter Server systems by using VMware Lookup Service.

vSphere Web Client does not support vCenter Server systems prior to 5.0.

- You can register multiple vCenter Server systems with a single vSphere Web Client.
- Register a given vCenter Server system with only one vSphere Web Client instance, rather than using multiple vSphere Web Client instances to manage that vCenter Server system.
Prerequisites

- Log in to the system on which the vSphere Web Client is installed. You cannot register a vCenter Server system with the client from a remote system.
- Ensure that you have login credentials with administrator privileges for the vCenter Server system that you are registering.
- If you want to use the server IP address to access the vSphere Web Client and your browser uses a proxy, add the server IP address to the list of proxy exceptions.

Procedure

1. Open a Web browser and go to either of the following URLs.

   **NOTE** Use the localhost or loopback address instead of the server IP address if you want to access the administration tool.

   - https://localhost:9443/admin-app
   - https://127.0.0.1:9443/admin-app

   The vSphere Web Client Administration Tool appears.

2. Click Register vCenter Server.

3. In the vCenter Server URL text box, type the server name or IP address of the vCenter Server system. Do not include http:// or https://.

4. Type the user name and password for the vCenter Server system.

5. In the vSphere Web Client server name or IP field, enter the IP address or host name of the machine where the vSphere Web Client is installed. For example, hostname.example.com or 10.111.123.xx.

   **NOTE** Do not use the localhost URL for the vSphere Web Client. If you enter the localhost URL, the license reporting functionality will not be available in the vSphere Client, unless the vSphere Web Client and vCenter Server are installed on the same system.

6. Click Register.

You can now use this instance of the client to log in to the vCenter Server system. In the Web browser, open https://client-hostname:port/vsphere-client/ to access the vSphere Web Client and log in to the client, where client-hostname is the host name or IP address of the machine where vSphere Web Client is installed and port is the port used by vSphere Web Client. For more information, see the vCenter Server and Host Management Guide.

Register vCenter Server with the vSphere Web Client from the Command-line

If you are using the VMware vCenter Server Appliance, you must register a vCenter Server 5.0 system with the vSphere Web Client from the command-line.

Because the admin-app user interface is not available on the vCenter Server Appliance, to register a vCenter Server system with the vSphere Web Client, you must register from the command-line using admin-cmd.sh.
Procedure

- Enter the following command on the vCenter Server Appliance:

  ```bash
  /usr/lib/vmware-vsphere-client/scripts/admin-cmd.sh register
  https://<WebClient_IPorHostName>:<WebClient_HttpsPort>/vsphere-client <VC_IP> <VC_Admin-User>
  <VC_Admin-Passwd>
  ```

Example: Passwords with Special Characters

If you use any special characters for the administrator password, you must enclose the password in single quotes.

```bash
```

Virtual Machine Requirements

You must meet certain requirements before you start deploying the vCenter Infrastructure Navigator virtual appliance on the vSphere Client and vSphere Web Client.

**Table 2-1. Virtual Machine Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 vCPU</td>
</tr>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Disk size</td>
<td>20 GB</td>
</tr>
<tr>
<td>Network</td>
<td>1 Gbps</td>
</tr>
</tbody>
</table>

Additionally, you also need vCenter Infrastructure Navigator OVA to be deployed on the vCenter Server and predefined static IP pool on desired port groups.

ESX/ESXi Requirements for vCenter Infrastructure Navigator

Apart from all builds of ESXi 5.x version, following ESX/ESXi versions are supported..

**Table 2-2. Supported ESX/ESXi versions**

<table>
<thead>
<tr>
<th>Server</th>
<th>ESX (ServerPkg)</th>
<th>ESXi (VMvisorPkg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.5 P25</td>
<td>391406, 437453, 604481, 702112, 725354, 725378</td>
<td>408533, 634899, 634900, 702903, 726914, 726917</td>
</tr>
<tr>
<td>4.0.0 U3</td>
<td>398348, 398350, 480973, 480974, 504849, 504850, 538074, 660575, 660580, 702116, 702117, 721907, 721909</td>
<td>403553, 481212, 481518, 523312, 523313, 540755, 540756, 660861, 660869, 703609, 703665, 728611, 728612</td>
</tr>
<tr>
<td>4.1.0 P03</td>
<td>433742, 449664, 477600, 477631, 502767, 502790, 538356, 538358, 582267, 582832, 659050, 659051, 702113, 702114, 721871, 721872</td>
<td>438303, 449808, 502847, 502854, 544764, 544767, 582837, 523955, 584154, 650334, 659759, 659760, 702896, 702897, 728620, 728622</td>
</tr>
</tbody>
</table>
Software Requirements for vCenter Infrastructure Navigator

You must also meet certain software requirements before you proceed with the deployment of vCenter Infrastructure Navigator virtual appliance.

Table 2-3. Software Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Infrastructure 5.0 and 5.1</td>
<td>vCenter Server 5.0 update 1 and vCenter Server 5.1. The user interface of the vCenter Infrastructure Navigator 2.0 virtual appliance that is deployed on vCenter Server 5.0 can only be viewed from the vSphere Web Client 5.1. <strong>Note</strong> In you are using vCenter Server 5.0 version, then apart from vSphere 5.1 Web Client you need to deploy vCenter Single Sign-On (SSO). For more information about vCenter Single Sign-On, see “Using vCenter Single Sign-On with vSphere,” on page 17.</td>
</tr>
<tr>
<td>vSphere Web Client</td>
<td>vSphere 5.1 Web Client. To enable connectivity to a vCenter Server 5.0 system with the vSphere Web Client 5.1, you need to register it with the vSphere Web Client using the vSphere Web Client Administration Tool. For more information about how to register vCenter Server 5.0 system with the vSphere 5.1 Web Client, see “Register vCenter Server 5.0 System with the vSphere 5.1 Web Client,” on page 11.</td>
</tr>
<tr>
<td>Virtual Center</td>
<td>Virtual Center IP address and administrator credentials.</td>
</tr>
<tr>
<td>Web browser</td>
<td>Microsoft Internet Explorer 7, 8, and 9, Google Chrome 14 or later, or Firefox 3.6 or later version. <strong>Note</strong> vSphere Web Client 5.1 requires Adobe Flash Player 11.1.0 or later to be installed in your browser.</td>
</tr>
<tr>
<td>Remote desktop</td>
<td>Remote desktop access to the Virtual Center with installed Web browser.</td>
</tr>
</tbody>
</table>

vCenter Infrastructure Navigator Port Requirements

vCenter Infrastructure Navigator requires certain TCP ports to be open for access.

Table 2-4. Port Requirements

<table>
<thead>
<tr>
<th>Port number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From your PC to vCenter Infrastructure Navigator (configure vCenter Infrastructure Navigator)</td>
<td>For appliance Web console</td>
</tr>
<tr>
<td>5480</td>
<td>For appliance Web console</td>
</tr>
<tr>
<td>5489</td>
<td>To communicate with VMware Update Manager (VUM). <strong>Note</strong> This port is only used in the environment where VUM is installed.</td>
</tr>
<tr>
<td>22</td>
<td>To enable SSH access to the vCenter Infrastructure Navigator virtual appliance.</td>
</tr>
<tr>
<td>vCenter Server to vCenter Infrastructure Navigator</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>2868</td>
<td>For plug-in download. This download happens as part of the registration process.</td>
</tr>
<tr>
<td>6969</td>
<td>For connectivity from vSphere Web Client to vCenter Infrastructure Navigator.</td>
</tr>
<tr>
<td>vCenter Infrastructure Navigator to vCenter Server</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>Port number</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>80</td>
<td>To access vSphere Web service API.</td>
</tr>
<tr>
<td>10109</td>
<td>To access vSphere Inventory Service.</td>
</tr>
<tr>
<td>vCenter Infrastructure Navigator to target hosts and virtual machines</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
<tr>
<td>443</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
<tr>
<td>902</td>
<td>For VIX protocol on target hosts to perform discovery.</td>
</tr>
</tbody>
</table>

**Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Web Client**

You can deploy vCenter Infrastructure Navigator virtual appliance by using vSphere Web Client. VMware provides the appliance in an OVA format. In your environment, if multiple vCenter Servers are registered by Single Sign On (SSO) to the same vSphere Web Client, you need to deploy a separate instance of vCenter Infrastructure Navigator for each vCenter Server.

**Prerequisites**

- Log in to the vSphere Web Client as a user with administrator privileges.
- Ensure that the virtual machine meets all requirements described in “Virtual Machine Requirements,” on page 13.
- Configure vCenter Managed IP address so that the vCenter Infrastructure Navigator virtual appliance can access the vCenter Server.
- Download the vCenter Infrastructure Navigator virtual appliance files from the VMware Web site.
- Install Client Integration Plug-in 5.1.0 on the system from where you are deploying OVF template.

**Procedure**

1. In the vSphere Web Client, click **Host and Clusters**.
2. Right-click the vCenter Server on which you want to deploy vCenter Infrastructure Navigator and select **Deploy OVF template**.
3. Browse to the OVA file and select it, or enter the URL from where you want to deploy the OVA template, and click **Next**.
   
   The Review details screen appears. Click **Next**.
4. Accept the End User License Agreement and click **Next**.
5. Select name and folder screen appears. Type a unique virtual appliance name according to the IT naming convention of your organization.
6. Select the folder or datacenter where you want to deploy the OVF, and click **Next**.
   
   If more than one datacenter is present, you must select the datacenter on which you want to deploy the virtual appliance.
7. On the Select a resource screen, select the location to run the deployed OVF template, and click **Next**.
   
   The Select storage screen appears where you can select the location to store the files of the deployed OVF template.
8. From the **Select virtual disk format** drop-down menu, select **Thin Provision** as the disk format, and click **Next**.
9. Configure the networks the deployed template should use, and click **Next**.
10 Type and confirm the administrative password for the root account.

11 Leave the Default Gateway, DNS, Network 1 IP Address, and Network 1 Netmask parameters blank if you want to acquire these values from a DHCP server, and click Next.

The vService Bindings screen appears.

12 If you have configured the vCenter Managed IP address, you can proceed ahead with deployment and click Next.

A Ready to Complete screen displays a summary of the deployment settings.

13 Select Power on after deployment, and then click Finish.

The process of deploying the vCenter Infrastructure Navigator virtual appliance starts.

The process of deploying the vCenter Infrastructure Navigator virtual appliance might take several minutes. After the process is complete, the vCenter Infrastructure Navigator OVA is deployed on your vSphere Web Client. Log out of the vSphere Web Client and log in again.

What to do next

You must type a valid license and start the discovery process. For more information, see “vCenter Infrastructure Navigator Licensing,” on page 19.

Deploy an vCenter Infrastructure Navigator Virtual Appliance by Using vSphere Client

You can use the vSphere Client user interface to deploy the vCenter Infrastructure Navigator virtual appliance. VMware provides the appliance in an OVA format. If multiple vCenter servers are registered through the same SSO, you need to deploy vCenter Infrastructure Navigator on all the vCenter servers.

Prerequisites

- Log in to the vSphere Client as a user with administrator privileges.
- Ensure that the virtual machine meets all requirements as described in “Virtual Machine Requirements,” on page 13 section.
- Configure vCenter Managed IP address so that the vCenter Infrastructure Navigator virtual appliance can access the vCenter Server. To configure vCenter Managed IP address in the vSphere Client, navigate to Administration > vCenter Server Settings > Runtime Settings and enter the IP address of the vCenter Server in vCenter Server Managed IP field.
- Download the vCenter Infrastructure Navigator virtual appliance files from VMware Web site.

Procedure

1 In the vSphere Client, navigate to File > Deploy OVF Template.

2 Browse to the OVA file and select it and click Next.

3 In the OVF Template Details screen, Click Next and accept End User License Agreement and then click Next.

4 In the Name and Location screen, type a unique virtual appliance name according to the IT naming convention of your organization, and click Next.

If more than one Datacenter is present, you must select the Datacenter on which you want to deploy the virtual appliance.

5 If the Host/Cluster screen appears, select the host or cluster where you want to deploy the virtual appliance, and click Next.
6 If the Resource Pool screen appears, select the resource pool within which you want to deploy the virtual appliance, and click **Next**.

7 In the Disk Format screen, select **Thin Provision** as the disk format, and click **Next**.

   The Network Mapping screen appears.

8 Select a network for the OVA, and click **Next**.

   The Properties screen appears.

9 Enter the administrative password for the root account in the **Enter password** field and enter the same password in **Confirm password** field.

10 Leave the **Default Gateway**, **DNS**, **Network 1 IP Address**, and **Network 1 Netmask** parameters blank if you want to acquire these values from DHCP server. You can also configure static IP addresses manually. Click **Next**.

   The Configure Service Bindings screen appears.

11 If you have configured the vCenter Managed IP address, you can proceed ahead with deployment and click **Next**.

   The Ready to Complete screen displays a summary of the deployment settings.

12 Select **Power on after deployment**, and then click **Finish** to confirm the settings and begin the deployment.

   The process of deploying the vCenter Infrastructure Navigator virtual appliance starts.

   The process of deploying the vCenter Infrastructure Navigator virtual appliance might take several minutes. After the process is complete, the vCenter Infrastructure Navigator OVA is deployed on your vSphere Client. Also, the vCenter Infrastructure Navigator is preparing the environment for discovery message appears in the **Tasks & Events** tab of the vSphere Client. If you are logged in to the vSphere Web Client, log out and log in again.

**What to do next**

You must now enter a valid license and start the discovery process. For more information about licensing and starting of the discovery process, see Chapter 3, “Setting Up vCenter Infrastructure Navigator,” on page 19.

**Using vCenter Single Sign-On with vSphere**

You use vCenter Single Sign-On to authenticate and manage vCenter Server users.

In vCenter Server versions earlier than vCenter Server 5.1, when a user connects to vCenter Server, vCenter Server authenticates the user by validating the user against an Active Directory domain or the list of local operating system users. In vCenter Server 5.1, users authenticate through vCenter Single Sign-On.

The Single Sign-On administrative interface is part of the vSphere Web Client. To configure Single Sign-On and manage Single Sign-On users and groups, you log in to the vSphere Web Client as a user with Single Sign-On administrator privileges. This might not be the same user as the vCenter Server administrator. Enter the credentials on the vSphere Web Client login page and upon authentication, you can access the Single Sign-On administration tool to create users and assign administrative permissions to other users.

vSphere 5.1 users have the option of logging in to vCenter Server with the vSphere Client or with the vSphere Web Client.

- Using the vSphere Client, you log in to each vCenter Server system separately. All linked vCenter Server instances are visible on the left pane of the vSphere Client. The vSphere Client does not show vCenter Server systems that are not linked to the vCenter Server that the user logged in to unless the user connects to those vCenter Server systems explicitly. This behavior is unchanged from vCenter Server versions earlier than version 5.1.
Using the vSphere Web Client, you authenticate to vCenter Single Sign-On by entering your credentials on the vSphere Web Client login page. You can then view all of the vCenter Server instances for which you have permissions. After you connect to vCenter Server, no further authentication is required. The actions that you can perform on objects depend on the user’s vCenter Server permissions on those objects.

For versions earlier than vCenter Server 5.1, you must explicitly register each vCenter Server system with the vSphere Web Client. For vCenter Server 5.1, vCenter Server systems are automatically detected and are displayed in the vSphere Web Client inventory. For more information about configuring vCenter Single Sign On, see http://pubs.vmware.com/vsphere-51/index.jsp.
After you deploy vCenter Infrastructure Navigator virtual appliance you must first enter a valid license of the vCenter Infrastructure Navigator. After you enter a valid license, you can start the application discovery process, set the vCenter Server credentials, and integrate SRM. You can also get the system information and product logs information.

This chapter includes the following topics:

- “vCenter Infrastructure Navigator Licensing,” on page 19
- “Privileges Required for vCenter Infrastructure Navigator,” on page 21
- “Select vCenter Server,” on page 24
- “View System Information,” on page 24
- “Managing Application Discovery,” on page 25
- “Update vCenter Credentials,” on page 26
- “Site Recovery Manager Integration with vCenter Infrastructure Navigator,” on page 26
- “Update SRM Administrator Credentials,” on page 27
- “Creating Product Support Package,” on page 27
- “Upgrading vCenter Infrastructure Navigator Knowledge Base,” on page 28
- “vCenter Infrastructure Navigator Log Files,” on page 28

**vCenter Infrastructure Navigator Licensing**

If you deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server, the virtual appliance is deployed without a license key. As a result, application discovery is disabled. You must enter a valid license key to start the application discovery process.

After you enter a valid license key, the vCenter Infrastructure Navigator monitors the number of virtual machines discovered by vCenter Infrastructure Navigator with regards to the number of virtual machines allowed. You can acquire a license depending on the number of virtual machines and applications running in your environment.

vCenter Infrastructure Navigator supports suite licenses for vCenter Server 5.1 and standalone licenses for vCenter Server 5.0. Table 3-1 lists the vCenter Server versions and its supported licenses for the vCenter Infrastructure Navigator.
Table 3-1. Supported Licenses

<table>
<thead>
<tr>
<th>vCenter Server Version</th>
<th>Supported Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCenter Server 5.1</td>
<td>VMware vCenter Operations Management Suite 5.6 or later, and VMware vCloud Advanced and Enterprise Suite 5.1 or later.</td>
</tr>
<tr>
<td>vCenter Server 5.0</td>
<td>Only vCenter Infrastructure Navigator 2.x Standalone.</td>
</tr>
</tbody>
</table>

Licensing in Single Sign On Mode

In SSO mode you need to deploy a separate instance of vCenter Infrastructure Navigator for each vCenter Server. To enable the discovery process, you must enter a license key for all the instances of vCenter Infrastructure Navigator under the licensing section of vSphere Web Client.

**Note** For each vCenter Infrastructure Navigator virtual appliance installed on vCenter Server 5.0 that is registered to the vSphere 5.1 Web Client, you need to follow the same process.

Apply vCenter Infrastructure Navigator License by Using vSphere Web Client

The vCenter Infrastructure Navigator virtual appliance is deployed without a license key. You can apply the license key by using vSphere Web Client to start the application discovery process.

**Prerequisites**

Deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server.

**Procedure**

1. Log in to the vSphere Web Client as an administrator.
2. Navigate to Administration > Licensing > Licenses.
3. From the vCenter Server drop-down menu, select the vCenter Server instance where vCenter Infrastructure Navigator is deployed.
4. Click the Solutions tab and select the vCenter Infrastructure Navigator virtual appliance for which you want to assign the license.
5. Click the Assign License Key icon 📋.
6. From the licensing method drop-down menu, select Assign a new license key.
7. Type the license key, and type an optional label for the key.
8. Click OK.

The license key is applied for the vCenter Infrastructure Navigator virtual appliance. You can now start the discovery process.

Apply vCenter Infrastructure Navigator License

vCenter Infrastructure Navigator virtual appliance is deployed without a license key. Apply the license key to start the application discovery process.

**Prerequisites**

Deploy the vCenter Infrastructure Navigator virtual appliance on the vCenter Server.
Procedure

1. Log in to the vSphere Client as an administrator.
2. Navigate to View > Administration > Licensing.
   The licensing window appears.
3. Select the Asset check box.
   The vCenter Infrastructure Navigator virtual appliance is listed.
4. Double-click the vCenter Infrastructure Navigator virtual appliance.
   The Assign License: VMware Infrastructure Navigator window appears.
5. Select the Assign a new license key to this solution check box.
6. Click Enter Key.
   The Add License Key window appears.
7. Type a valid license key and an optional label for the new license key and click OK.
   The license key is displayed.
8. Click OK.

The license key is applied for the vCenter Infrastructure Navigator virtual appliance. You can now start the discovery process.

Evaluation License for vCenter Infrastructure Navigator

The evaluation license of vCenter Infrastructure Navigator is time based and is preset to expire in 30 days. If you apply an evaluation license for vCenter Infrastructure Navigator, every time you log in to the vSphere client and vSphere Web Client, an alert warning with the number of days left for the license to expire is displayed.

You can apply an evaluation license by using the vSphere Client as described in “Apply vCenter Infrastructure Navigator License,” on page 20. After you apply an evaluation license, the Start Discovery button in vSphere Web Client is enabled, but the discovery is not started, and a message that asks you to apply a license no longer appears. If an evaluation license expires and you have not disabled or uninstalled vCenter Infrastructure Navigator, an alert warning that the license has expired is displayed. However, even after the license expires, the vCenter Infrastructure Navigator plug-in is not disabled. The discovery process is not affected by expiration of the license and you can still view and manage the information presented by vCenter Infrastructure Navigator.

Privileges Required for vCenter Infrastructure Navigator

You must log in to vSphere Web Client as an administrator to use the services offered by vCenter Infrastructure Navigator.

An administrator is a user that is assigned the administrator role on the vCenter Server or a user in a group that is assigned the administrators role on the vCenter Server. A user or group must be assigned the administrator role on the root folder and all the child objects that are propagating from root folder.

Assign Administrator Privileges by Using vSphere Web Client

You can assign administrator privileges to a user or group on the root folder and all the child objects that are propagating from the root folder by using vSphere Web Client.

Procedure

1. Log in to the vSphere Web Client as an administrator.
At the vCenter entity level, click the Manage tab and select Permissions.

Click Add Permission.

Select Administrator from the Assigned Role drop-down menu. This drop-down menu displays all the roles that are assigned to the object. When the role appears, the privileges contained in the role are listed in the section below the role title.

Select Propagate to children of the vCenter Server name virtual machine.

Click Add.

Select Propagate to Child Objects.

Click Add.

The server adds administrator privileges to the user.

Assign Administrator Privileges by Using vSphere Client

To view services offered by vCenter Infrastructure Navigator when you log in to vSphere Client, you must assign administrative privileges to the user or group on the root folder and all the child objects that are propagating from the root folder in vSphere Client.

Procedure

1. Log in to the vSphere Client.

2. On the vCenter entity root level, right-click and select Add Permission. The Assign Permissions window appears.

3. Select Administrator from the Assigned Role drop-down menu. This menu displays all the roles that are assigned to the object. When the role appears, the privileges contained in the role are listed in the section below the role title.

4. Select Propagate to Child Objects.

5. Click Add. The Select Users and Groups window appears.

6. Select the domain where the user or group is located from the Domain drop-down menu.

7. Type a name in the Search box or select a name from the Name list, and click Add. The name is added to the Users or Groups list.

8. Repeat Step 6 through Step 8 to add additional users or groups.

9. Click OK.

10. To finish the task, click OK.

The server adds administrator privileges to the user.
Minimal Privileges for Discovery

To accommodate security needs vCenter Infrastructure Navigator supports some minimally privileged users. These users cannot log in into the vSphere Web Client, but their credentials can be used to perform the discovery process.

vCenter Infrastructure Navigator necessitates users to have administrative privileges. For more information, see “Privileges Required for vCenter Infrastructure Navigator,” on page 21, but to accommodate security needs, vCenter Infrastructure Navigator also supports some minimally privileged users for performing discovery. For more information, see “Creating a Role with Minimal Privileges to Enable the Discovery by Using vSphere Client,” on page 23.

Creating a Role with Minimal Privileges to Enable the Discovery by using vSphere Web Client

You can create a role with Guest operating system management by VIX API and Console interaction privileges. After you create a role, you must assign a user to this role on the entire datacenter by assigning the user to the root folder and all the child objects that are propagating from the root folder in vSphere Client.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. From inventory menu, navigate to Administration > Role Manager.
   The Roles screen appears.
3. Click Create role action icon.
5. Select Guest operating system management by VIX API and Console interaction check boxes.
6. Type a name in the Role name text box.
7. Click OK.

A role is created with Guest operating system management by VIX API and Console interaction privileges. You can now go ahead and assign a user to this role by selecting this role as a role in “Assign Administrator Privileges by Using vSphere Client,” on page 22 procedure. After the completion of the procedure, the user has required privileges to enable the discovery process.

Creating a Role with Minimal Privileges to Enable the Discovery by Using vSphere Client

You can create a role with Guest operating system management by VIX API and Console interaction privileges. After you create a role, you must assign a user to this role on the entire datacenter by assigning the user to the root folder and all the child objects that are propagating from the root folder in vSphere Client.

Procedure

1. Log in to the vSphere Client as an administrator.
2. From the View menu, navigate to Administration > Roles.
   The Roles screen appears.
3. Click Add Role.
   The Add New Role window appears.
Select Guest operating system management by VIX API and Console interaction check boxes.

Type a name in the Name text box.

Click OK.

A role is created with Guest operating system management by VIX API and Console interaction privileges. You can now go ahead and assign a user to this role by selecting this role as a role in “Assign Administrator Privileges by Using vSphere Client,” on page 22 procedure. After the completion of the procedure, the user has required privileges to enable the discovery process.

Select vCenter Server

If you are working with multiple vCenter Server instances, you can select the vCenter Server that you want to work with. vCenter Infrastructure Navigator updates the information pertaining to the selected vCenter Server.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. On the inventory menu, click Infrastructure Navigator.
   The vCenter Infrastructure Navigator home page appears.
3. Click the Settings tab.
4. From the vCenter Server drop-down menu, select the vCenter Server that you want to work with.

The vCenter Infrastructure Navigator virtual appliance information pertaining to the selected vCenter Server is updated. If vCenter Infrastructure Navigator is not installed on the selected vCenter Server, this message is displayed.

*Infrastructure Navigator is not installed on this vCenter Server.*

If you are working with multiple vCenter servers, select the vCenter Server where Infrastructure Navigator is installed.

If you want to uninstall Infrastructure Navigator, you must restart the vSphere Web Client service to complete the uninstall process. You can then delete the virtual appliance.

View System Information

The Settings tab displays the product version and knowledge base version of the vCenter Infrastructure Navigator virtual appliance. This page also displays the build number of the vCenter Infrastructure Navigator virtual appliance that you are currently using.

Procedure

1. Log in to the vSphere Web Client as an administrator.
2. From the inventory menu, click Infrastructure Navigator.
   The vCenter Infrastructure Navigator home page appears.
3. Click the Settings tab.
   The page that has system information appears.
Managing Application Discovery

In the vSphere Web Client, the Settings tab provides the functionality to start and stop the application discovery process. You can start the application discovery process to retrieve information about the applications running in your environment.

Start Application Discovery

vCenter Infrastructure Navigator utilizes VMware tools to access the virtual machines. Start the application discovery process to retrieve the information about the applications running in your vCenter Server environment.

Prerequisites

- Ensure that you have entered the license for the vCenter Infrastructure Navigator virtual appliance. For more information, see “vCenter Infrastructure Navigator Licensing,” on page 19.
- Ensure that you have a user with the required privileges to start the discovery process. For more information, see “Privileges Required for vCenter Infrastructure Navigator,” on page 21.

Procedure

1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
   The vCenter Infrastructure Navigator home page appears.
3. Click the Settings tab.
4. Click Turn On Discovery.
   The Enter vCenter administrator credentials window appears.
5. Type the user name and password and click OK.

   If you are starting the application discovery for the first time, you need to provide the vCenter Server administrator credentials or the privileges described in “Minimal Privileges for Discovery,” on page 23.

   If the credentials are valid, vCenter Infrastructure Navigator starts the discovery of all the applications in your environment and the message Application Discovery is running is displayed.

   **NOTE** After the discovery starts, the vCenter Infrastructure Navigator is discovering message appears in the vSphere Client.

Stop Application Discovery

You can stop the application discovery process and to ensure all the discovery actions performed by vCenter Infrastructure Navigator is stopped.

Procedure

1. Log in to vSphere Web Client.
2. From the inventory menu, click Infrastructure Navigator.
   The vCenter Infrastructure Navigator home page appears.
3. Click the Settings tab.
4  Click **Turn Off Discovery**.

vCenter Infrastructure Navigator stops the application discovery process and the message *Application Discovery is stopped* is displayed.

**Update vCenter Credentials**

If you have changed or modified credentials of the administrator or minimally privileged user, you must update these credentials in the **Settings** tab of the vCenter Infrastructure Navigator in the vSphere Web Client.

**Procedure**

1  Log in to vSphere Web Client.

2  From the inventory menu, click **Infrastructure Navigator**.

The vCenter Infrastructure Navigator home page appears.

3  Click the **Settings** tab.

4  Click the [user: <user name>] link.

The Enter vCenter administrator credentials window appears.

5  Type the user name and password and click **OK**.

If the credentials are valid, vCenter Infrastructure Navigator updates the credentials successfully.

**Site Recovery Manager Integration with vCenter Infrastructure Navigator**

The Site Recovery Manager (SRM) integration with vCenter Infrastructure Navigator displays the SRM Protection Groups and SRM Recovery Plans of the selected virtual machine.

**Start SRM Integration**

Start the SRM integration to display the vCenter Site Recovery Manager information in the inventory table and dependency map.

**Procedure**

1  Log in to vSphere Web Client.

2  From the inventory menu, click **Infrastructure Navigator**.

The vCenter Infrastructure Navigator home page appears.

3  Click the **Settings** tab.

4  Click **Turn On Integration**.

The Enter vCenter Site Recovery Manager administrator credentials window appears.

5  Type the user name and password and click **OK**.

You need to provide the SRM administrator credentials if you are starting the integration for the first time.

If the credentials are valid, integration of SRM is started and the message *Integration is on* is displayed.
Stop SRM Integration

Stop SRM integration to remove all columns and indicators of SRM from the vCenter Infrastructure Navigator screen.

**Procedure**

1. Log in to vSphere Web Client.
2. From the inventory menu, click **Infrastructure Navigator**.
   
   The vCenter Infrastructure Navigator home page appears.
3. Click the **Settings** tab.
4. Click **Turn Off Integration**.
   
   vCenter Infrastructure Navigator stops SRM integration and the message **Integration is off** is displayed.

Update SRM Administrator Credentials

If you have changed SRM credentials, you must update the credentials on the **Settings** tab of the vCenter Infrastructure Navigator virtual appliance in the vSphere Web Client.

**Procedure**

1. Log in to vSphere Web Client.
2. From the inventory menu, click **Infrastructure Navigator**.
   
   The vCenter Infrastructure Navigator home page appears.
3. Click the **Settings** tab.
4. Click the `user: <user name>` link.
   
   The Enter Site Recovery Manager administrator credentials window appears.
5. Type the user name and password and click **OK**.
   
   If the credentials are valid, vCenter Infrastructure Navigator updates the credentials successfully.

Creating Product Support Package

You can use the vCenter Infrastructure Navigator product support package to get system information and product logs information.

**Procedure**

1. Connect to the vCenter Infrastructure Navigator virtual machine through SSH.
2. Navigate to `/opt/vadm-engine/bin/` by running the `cd /opt/vadm-engine/bin/` command.
3. Create the product support package by running the `./support_package.sh` command.

A `vadm_server_support_package_*_.tgz` file is created and is stored in `/opt/vadm-engine/bin/` folder.
Upgrading vCenter Infrastructure Navigator Knowledge Base

You can update the vCenter Infrastructure Navigator knowledge base with new updates without installing a new vCenter Infrastructure Navigator virtual appliance.

**Prerequisites**

The new knowledge base JAR file must be present under the `/opt/vadm-activecollector/bin` directory.

**Procedure**

1. Connect to the vCenter Infrastructure Navigator virtual machine through SSH.

2. Navigate to `/opt/vadm-activecollector/bin` by running the command.
   
   ```
   cd /opt/vadm-activecollector/bin
   ```

3. Run the command.
   
   ```
   ./update_kb.sh new_knowledge_base_filename.jar
   ```

   The update procedure takes between one to two minutes to finish.

4. (Optional) You can verify the progress by running commands.
   
   ```
   tail -f /var/log/vadm/engine.log, tail -f /var/log/vadm/activecollector.log, ll /opt/vadm-activecollector/lib, and ll /opt/vadm-activecollector/tmp
   ```

The vCenter Infrastructure Navigator knowledge base is updated.

vCenter Infrastructure Navigator Log Files

All vCenter Infrastructure Navigator log files are located in `/var/log/vadm/`. The following table lists all the generic log files that are available in vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Filename</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.log</td>
<td>The active collector log file</td>
</tr>
<tr>
<td>dbconfig.log</td>
<td>The database operations log file</td>
</tr>
<tr>
<td>engine.log</td>
<td>The engine log file</td>
</tr>
<tr>
<td>engine.catalina.log</td>
<td>Internal tc Server log file</td>
</tr>
<tr>
<td>db/postgresql.log</td>
<td>PostgreSQL log file</td>
</tr>
<tr>
<td>kb-update.log</td>
<td>Logs knowledge base update</td>
</tr>
<tr>
<td>update.log</td>
<td>Logs the virtual appliance updates</td>
</tr>
</tbody>
</table>

The following table lists the service log files available in vCenter Infrastructure Navigator.

<table>
<thead>
<tr>
<th>Services Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activecollector.stdout</td>
<td>For the active collector services</td>
</tr>
<tr>
<td>listener.stdout</td>
<td>For the listener services</td>
</tr>
<tr>
<td>engine.catalina-out.log</td>
<td>For the engine services</td>
</tr>
</tbody>
</table>

The vSphere Web Client log file is located on the vSphere Web Client server at `C:\ProgramData\VMware\vSphere Web Client\serviceability\logs\vsphere_client_virgo.txt`. 
Security Overview

vCenter Infrastructure Navigator offers strong network security to protect sensitive corporate data. The vCenter Infrastructure Navigator plug-in leverages the vCenter Server for authentication and eliminates the user management requirement.

vCenter Infrastructure Navigator uses PostgreSQL as the database and other individual process that are limited to a single virtual appliance. This limit reduces the vulnerability of the system by allowing the components to perform inter-process communication on the local protected channels.

This chapter includes the following topics:
- “Firewall for vCenter Infrastructure Navigator,” on page 29
- “Protecting Sensitive Files,” on page 30
- “Securing vCenter Infrastructure Navigator,” on page 30

Firewall for vCenter Infrastructure Navigator

vCenter Infrastructure Navigator uses the SLES, SuSEfirewall2 firewall. vCenter Infrastructure Navigator requires certain TCP ports to be open for proper operation of the product.

The firewall is configured so that vCenter Infrastructure Navigator can use the following ports.

<table>
<thead>
<tr>
<th>Table 4-1. Open Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Port Number</strong></td>
</tr>
<tr>
<td>5480</td>
</tr>
<tr>
<td>5489</td>
</tr>
<tr>
<td>22</td>
</tr>
<tr>
<td>80</td>
</tr>
<tr>
<td>2868</td>
</tr>
<tr>
<td>6969</td>
</tr>
</tbody>
</table>

The firewall is started during the first boot of the operating system. To stop the firewall, monitor its status, and start the firewall, you can use the following commands.
Table 4-2. Commands for Firewall

<table>
<thead>
<tr>
<th>Operation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>stop</td>
<td>/etc/init.d/SuSEfirewall2_setup stop</td>
</tr>
<tr>
<td>status</td>
<td>/etc/init.d/SuSEfirewall2_setup status</td>
</tr>
<tr>
<td>start</td>
<td>/etc/init.d/SuSEfirewall2_setup start</td>
</tr>
</tbody>
</table>

Protecting Sensitive Files

vCenter Infrastructure Navigator has some sensitive files that must be protected from unauthorised access as that might compromise vCenter Infrastructure Navigator security.

The `vadm.keystore` file, found under `/opt/vadm-engine/conf/` is a critical file that contains private key and certificate of the application. Unauthorized access to this file might give an attacker access to the vCenter Infrastructure Navigator database.

The `vadm.keystore` file is protected by access controls. Do not change the permissions on the file or folder as it might either give too much access, reduce security, or restrict access, thereby preventing vCenter Infrastructure Navigator from working.

For the access controls to work properly, access to the vCenter Infrastructure Navigator virtual appliance must be strictly limited to those with a need to log in, with the minimal levels of access required. This involves limiting the use of the root account. Any backups of the vCenter Infrastructure Navigator virtual appliance must be strictly protected and encrypted with the keys managed separately from the backups.

Securing vCenter Infrastructure Navigator

vCenter Infrastructure Navigator uses digital certificates to enable secure communication based on Transport Layer Security (TLS).

TLS is based on the Secure Sockets Layer (SSL) specifications developed by Netscape Communications and has been standardized by the Internet Engineering Task Force (IETF). TLS provides privacy of communication by using encryption and also allows you to verify the authenticity of the server with which you are communicating.

During the first boot of the appliance, a self-signed certificate is generated. This certificate is used for encrypted TLS communication between the vCenter Infrastructure Navigator virtual appliance and the vSphere Web Client.
You can upgrade vCenter Infrastructure Navigator virtual appliance without needing to redeploy virtual appliance again. Such an upgrade applies to vCenter Infrastructure Navigator Red Hat Package Manager (RPM) and third-party RPMs like RabbitMQ.

**Note** You must take a snapshot of the vCenter Infrastructure Navigator virtual appliance before you run the upgrade procedure. If any problems occur with virtual appliance after the upgrade, you can revert back to the snapshot.

This chapter includes the following topics:

- “vCenter Infrastructure Navigator Upgrade,” on page 31
- “Upgrade vCenter Infrastructure Navigator by Using Web Console,” on page 32
- “Upgrade Limitation for vCenter Infrastructure Navigator,” on page 32

### vCenter Infrastructure Navigator Upgrade

vCenter Infrastructure Navigator 1.2 and later can be upgraded to the highest supported version by using the vCenter Infrastructure Navigator Web console. You can use the **Update** tab in the vCenter Infrastructure Navigator Web console to upgrade the vCenter Infrastructure Navigator virtual appliance.

**Note** vCenter Infrastructure Navigator does not support upgrade through VMware Update Manager (VUM).

The **Settings** tab shows the setting of policies for periodically checking and installing vCenter Infrastructure Navigator virtual appliance updates.

**Table 5-1. Update Policies**

<table>
<thead>
<tr>
<th>Update Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No automatic updates</strong></td>
<td>This check box is selected by default. The virtual appliance does not check and install updates.</td>
</tr>
<tr>
<td><strong>Automatic check for updates</strong></td>
<td>The virtual appliance checks for updates at the scheduled time. If an update is available, it appears on the Update Status page.</td>
</tr>
<tr>
<td><strong>Automatic check and install updates</strong></td>
<td>The virtual appliance checks for updates at the scheduled time, and if updates are available, installs them.</td>
</tr>
</tbody>
</table>

If you select either **Automatic check for updates** or **Automatic check and install updates**, you can configure the scheduling. By default, the check occurs daily at 3:00 a.m. local time, as determined by your time zone setting.
By default, vCenter Infrastructure Navigator updates from the VMware vapp-updates Web site. You can choose instead to update from a CD-ROM or from an alternative update repository URL.

If you upgrade from 1.2 to 2.0 version, the discovery stops and Discovery is off message is displayed in the vSphere Web Client. If you try to start the discovery from the Settings tab, a message that asks you to assign a new license appears. You need to assign a new 2.x license to start the discovery process as the assignment of vCenter Infrastructure Navigator 1.2 license to 2.0 fails.

**Upgrade vCenter Infrastructure Navigator by Using Web Console**

You can upgrade the vCenter Infrastructure Navigator virtual appliance by using the vCenter Infrastructure Navigator Web console. The upgrade procedure performs all the operations required to upgrade the vCenter Infrastructure Navigator virtual appliance.

**Procedure**

1. Log in to the vCenter Infrastructure Navigator Web console.
2. Click the **Update** tab.
   The current status of vCenter Infrastructure Navigator virtual appliance is displayed.
3. Click **Check Updates**.
   The available updates are listed.
4. Click **Install Updates**.
   A message confirms that the update is in progress. After a successful update, the **Status** tab displays the Last Check and Last Update information.
5. Restart the vSphere Web Client service on the vCenter Server after you perform the update procedure.

**Upgrade Limitation for vCenter Infrastructure Navigator**

Some limitations are associated with the upgrading of the vCenter Infrastructure Navigator virtual appliance. You must keep these limitations in mind before upgrading the virtual appliance.

- No downgrade is possible after you perform the upgrade procedure. Consider taking a snapshot of the vCenter Infrastructure Navigator virtual appliance before you run the upgrade procedure.
- When using a Web console of vCenter Infrastructure Navigator virtual appliance, you can only upgrade to the highest version available.
- No authentication or access control mechanism is available to the catalog.
- After an upgrade, the **Application Dependencies** tab is available only after you restart the vSphere Web Client service on the vCenter Server.
- During the upgrade procedure, if you try to access the **Application Dependencies** tab in the vSphere Web Client, you might see a communication error message because during the upgrade the engine stops working.
Uninstalling vCenter Infrastructure Navigator

Perform the uninstall process if you want to remove the vCenter Infrastructure Navigator plug-in from the vCenter Server.

Uninstall vCenter Infrastructure Navigator Plug-in

Uninstall procedure removes the plug-in from the vCenter Server.

**Procedure**

1. Log in to vSphere Web Client.
2. From the inventory menu, click **Infrastructure Navigator**.
   The vCenter Infrastructure Navigator home page appears.
3. Click the **Settings** tab.
4. Click **Uninstall**.
   A confirmation message is displayed.
5. Click **Yes**.
   The uninstall process starts, and might take anywhere between 30 minutes to one hour depending on number of virtual machines and applications running in your environment.

After successful completion of the uninstall procedure the message, **Infrastructure Navigator is not installed on this vCenter Server.**

If you are working with multiple vCenter servers, select the vCenter Server where Infrastructure Navigator is installed.

If you want to uninstall Infrastructure Navigator, you must restart the vSphere Web Client service to complete the uninstall process. You can then delete the virtual appliance.

is displayed in the vSphere Web Client. Also, the **vCenter Infrastructure Navigator is cleaning up** message is displayed in the vSphere Client.

**What to do next**

After you uninstall the vCenter Infrastructure Navigator plug-in, you can power off and delete the vCenter Infrastructure Navigator virtual machine from the vCenter Server. You need to restart the vSphere Web Client service to enable the installation of new vCenter Infrastructure Navigator plug-in in the future.
Troubleshooting vCenter Infrastructure Navigator provides information about the problems that you might encounter when using vCenter Infrastructure Navigator and provides possible workarounds.

This chapter includes the following topics:

- “vCenter Certificate Error,” on page 35
- “Plug-In Does Not Work in vSphere Web Client After an Upgrade,” on page 36
- “Error in Retrieving Information Might Occur,” on page 36
- “Incorrect Marking of a Virtual Machine as an External Machine,” on page 36
- “Deployment Failure After IP Address Change,” on page 37
- “Failure of the Virtual Appliance After DHCP Selection,” on page 37
- “VMware Tools Compatibility Error,” on page 37
- “vCenter Infrastructure Navigator Authentication Failure,” on page 37
- “Navigation Problem Between Objects,” on page 38
- “Navigation Error,” on page 38
- “Error Message in Recent Tasks List,” on page 38
- “vCenter Infrastructure Navigator Plug-in Removal Failure,” on page 39

vCenter Certificate Error

If you try to manually replace the certificate on the vCenter Server, vCenter Infrastructure Navigator is not able to load the new certificate thumbprint.

**Problem**

If you delete the /opt/vmware/etc/vami/ovfEnv.xml file, the new file created at restart contains the old certificate's thumbprint.

**Solution**

1. Select the vCenter Infrastructure Navigator virtual machine and ensure that it is powered off.
2. Right-click the selected virtual machine and select **Edit Settings**.
3. Select the **vServices** tab.
4. Right-click **vCenter Extension vService Dependency** and click **Edit**.
5. Select **No Provider** from the **Provider** drop-down menu.
6 Click **OK** and click **OK** again.

**Solution**

Repeat steps 2 through 7 and in step 5 select **vCenter Extension vService** from the **Provider** drop-down menu. When you power on the virtual machine next time, its OVF environment is updated with the new vCenter certificate thumbprint.

**Plug-In Does Not Work in vSphere Web Client After an Upgrade**

If you upgrade to a new vCenter Infrastructure Navigator build, the plug-in does not work in vSphere Web Client.

**Problem**

After you upgrade to a new vCenter Infrastructure Navigator build and the log in to the vSphere Web Client, the plug-in does not appear in vSphere Web Client.

**Solution**

1. Restart the vSphere Web Client service.
2. Wait for five minutes and then log in again into the vSphere Web Client.

   The plug-in is now visible.

**Error in Retrieving Information Might Occur**

If you restart the vCenter Infrastructure Navigator virtual machine or the engine services, an error message is displayed.

**Problem**

If vCenter Infrastructure Navigator is unable to map services that are running on the selected vCenter entity, instead of the total number of services installed, an **Error retrieving information from Infrastructure Navigator** message is displayed.

**Solution**

Wait for few minutes and if the problem persists, restart the vCenter Infrastructure Navigator virtual appliance.

**Incorrect Marking of a Virtual Machine as an External Machine**

vCenter Infrastructure Navigator might incorrectly mark a virtual machine as an external machine.

**Problem**

vCenter Infrastructure Navigator can incorrectly mark a virtual machine as an external machine under the following conditions:

- Monitored virtual machine is configured with hardware version 4.
- Multiple IPv4 addresses are configured on the virtual machine.
- vCenter displays only one IP address for the virtual machine with hardware version 4, but according to vCenter Infrastructure Navigator, the IP address might be different. This issue does not occur with newer hardware versions, for example, hardware version 7 and 8.

**Solution**

If your virtual machine is located on an ESX 4.x or higher host, right click the powered-off virtual machine and select **Upgrade Virtual Hardware**.
Deployment Failure After IP Address Change

You cannot deploy the vCenter Infrastructure Navigator plug-in after you change the IP address of the vCenter Infrastructure Navigator virtual appliance.

Problem
If you change the IP address of the vCenter Infrastructure Navigator virtual appliance, the vCenter Infrastructure Navigator plug-in fails to deploy in the vSphere Web Client.

Solution
After the IP address change, restart the vCenter Infrastructure Navigator virtual appliance.

Failure of the Virtual Appliance After DHCP Selection

The vCenter Infrastructure Navigator virtual appliance does not work if you assign the IP address by using DHCP.

Problem
During the deployment of vCenter Infrastructure Navigator virtual appliance, if you assign the IP address to the vCenter Infrastructure Navigator virtual appliance by using DHCP, the virtual appliance does not work properly.

Solution
Restart the vCenter Infrastructure Navigator virtual appliance and the vSphere Web Client.

VMware Tools Compatibility Error

Virtual machine discovery might fail because of a VMware tools compatibility error.

Problem
If you attempt to discover virtual machines with a VMware Tools version lower than the one compatible with ESX host version 3.5, the discovery might fail with the error message Unknown discovery error.

Solution
Update VMware tools.

vCenter Infrastructure Navigator Authentication Failure

The vCenter Infrastructure Navigator plug-in does not appear in the vSphere Web Client after you restart vCenter Server.

Problem
After you restart vCenter Server, the vCenter Server fails to authenticate the vCenter Infrastructure Navigator plug-in and hence the Application Dependencies tab does not appear in vSphere Web Client.

Solution
Restart vCenter Infrastructure Navigator after you restart vCenter Server.
Navigation Problem Between Objects

Problem occurs when you navigate from one object to another in the left pane in the vSphere Web Client or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine.

Problem

When you navigate from one object to another in the left pane in the vSphere Web Client or when you navigate from the dependency map of one virtual machine to the dependency map of another virtual machine, the Loading... message might persist for a very long time in the user interface.

Solution

Navigate to a different object in the left pane or reload the vSphere Web Client.

Navigation Error

The vSphere Web Client displays an error message if you navigate from the VMs and Templates view to the vCenter Server root-level view.

Problem

In the vSphere Web Client, if you select the VMs and Templates view and navigate first to its folder level, then the Datacenter level, and finally to the vCenter Server root level, the Application Dependencies tab displays the This list is empty error message.

Solution

Refresh the vSphere Web Client page or navigate by using a different sequence to reach the vCenter Server root level.

Error Message in Recent Tasks List

If you log in to a non-English version of the vSphere Client, an error message might appear in the Recent Task list.

Problem

After you deploy vCenter Infrastructure Navigator on a non-English version of the vSphere Client, the Recent Task list might display a 1be1_not found error message. This error message also appears in the Task Console of the vSphere Web Client.

Cause

This issue is caused by a VPX i18nfilter limitation on the language fallback mechanism.
Solution

- For the vCenter Server on a Windows machine:
  
  a. Create dummy locale folder under directory `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale` in the vCenter Server. For example, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\de`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\fr`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ja`, `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\zh_CN`, or `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\ko`.

  b. Copy all the English resource files under `C:\Program Files\VMware\Infrastructure\VirtualCenter Server\extensions\com.vmware.vadm\locale\en` to the locale folders that you have created. The vCenter Server loads the strings correctly by using the dummy resource files.

- For the vCenter Server on a Linux machine:
  

  b. Copy all the English resource files under `/usr/lib/vmware-vpx/extensions/com.vmware.vadm/locale/en` to the locale folder that you have created. The vCenter Server loads the strings correctly by using the dummy resource files.

**vCenter Infrastructure Navigator Plug-in Removal Failure**

After you uninstall vCenter Infrastructure Navigator plug-in, the plug-in is not removed from the vSphere Web Client.

**Problem**

If you try to uninstall the vCenter Infrastructure Navigator plug-in from the vSphere Web Client, the plug-in is not removed. If you log in after the uninstall process, the Navigator tabs and portlets is present in the vSphere Web Client.

**Solution**

Restart the vSphere Web Client service.
Index

A
active directory domain 17
Active Discovery 8, 9
administrator privileges 23
administrator role 21
application discover process 19
application discovery 25
application services 8
applying license 20
architecture 8
assigning privileges 21
authentication failure 37

B
benefits 8

C
certificate error 35
certificates 30
child objects 21
compatibility error 37
configurations 9
Console interaction 23

D
data protection 29
Database component 9
deployment process 15, 16
DHCP post requisite 37

E
ESX/ESXi requirements 13
evaluation license 21

F
firewall 29
functionality 7

G
graphical user interface 9
Guest operating system management by VIX API 23

I
incorrect marking of a virtual machine 36
initiating SRM 26
installation process 16
installing 11
integration 7
intended audience 5
IP address change 37

K
knowledge base version 24

L
license key 20
licensing 19, 20
log files 28

M
minimal permission 23
minimal privileges 23
multiple vCenter Server instance 24

N
navigation error 38
navigation problem 38

O
OVA format 15
overview, vCenter Infrastructure Navigator 7

P
permission for users 21
plug-in 9
plug-in removal failure 39
plug-in upgrade 36
port requirements 14
preface 5
privileges 21
privileges to view data 22
product support package 27
product version 24

R
recent task list error 38
registering, vCenter Server 12
registration of vCenter Server 11
removing vCenter Infrastructure Navigator 33
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>root folder</td>
<td>22</td>
</tr>
<tr>
<td>RPM</td>
<td>31</td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td>29</td>
</tr>
<tr>
<td>select vCenter Server</td>
<td>24</td>
</tr>
<tr>
<td>sensitive data</td>
<td>29</td>
</tr>
<tr>
<td>sensitive files</td>
<td>30</td>
</tr>
<tr>
<td>Server component</td>
<td>9</td>
</tr>
<tr>
<td>server IP address</td>
<td>11</td>
</tr>
<tr>
<td>setting up the vCenter Infrastructure Navigator</td>
<td>19</td>
</tr>
<tr>
<td>Settings tab</td>
<td>31</td>
</tr>
<tr>
<td>single sign on</td>
<td>17</td>
</tr>
<tr>
<td>single sign on licensing</td>
<td>20</td>
</tr>
<tr>
<td>software requirements</td>
<td>14</td>
</tr>
<tr>
<td>SRM</td>
<td>7</td>
</tr>
<tr>
<td>SRM integration</td>
<td>26</td>
</tr>
<tr>
<td>SRM protection group</td>
<td>26</td>
</tr>
<tr>
<td>SRM protection plan</td>
<td>26</td>
</tr>
<tr>
<td>starting application discovery</td>
<td>25</td>
</tr>
<tr>
<td>static IP pool</td>
<td>13</td>
</tr>
<tr>
<td>Status tab</td>
<td>31</td>
</tr>
<tr>
<td>stop SRM integration</td>
<td>27</td>
</tr>
<tr>
<td>stopping application discovery</td>
<td>25</td>
</tr>
<tr>
<td>suite licensing</td>
<td>19</td>
</tr>
<tr>
<td>supported suites</td>
<td>19</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>troubleshooting</td>
<td>35</td>
</tr>
<tr>
<td>troubleshooting workaround</td>
<td>35</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>uninstall</td>
<td>33</td>
</tr>
<tr>
<td>uninstall process</td>
<td>33</td>
</tr>
<tr>
<td>uninstall vCenter Infrastructure Navigator</td>
<td>33</td>
</tr>
<tr>
<td>uninstalling</td>
<td>33</td>
</tr>
<tr>
<td>update policies</td>
<td>31</td>
</tr>
<tr>
<td>updating SRM credentials</td>
<td>27</td>
</tr>
<tr>
<td>updating vCenter credentials</td>
<td>26</td>
</tr>
<tr>
<td>upgrade limitation</td>
<td>32</td>
</tr>
<tr>
<td>upgrading knowledge base</td>
<td>28</td>
</tr>
<tr>
<td>upgrading vCenter Infrastructure Navigator</td>
<td>31</td>
</tr>
<tr>
<td>user management</td>
<td>17</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>valid credentials</td>
<td>19</td>
</tr>
<tr>
<td>valid license</td>
<td>19</td>
</tr>
<tr>
<td>vCenter entity error</td>
<td>36</td>
</tr>
<tr>
<td>vCenter Infrastructure Navigator upgrade</td>
<td>32</td>
</tr>
<tr>
<td>vcenter managed IP address</td>
<td>15</td>
</tr>
<tr>
<td>vCenter managed IP address</td>
<td>15, 16</td>
</tr>
</tbody>
</table>